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RKX-EVK-001 and ROHM EVK EVB 

ROHM EVK SW User’s Guide 
 

The ROHM EVK is an easy-to-use platform that allows evaluation of ROHM products. The evaluation kit is based on the Infineon CY8CKIT-059 

Prototyping Kit featuring an integrated SoC based on the ARM® Cortex®-M3 CPU with powerful analog and digital peripherals. The ROHM EVK 

comes with a highly configurable RKX-A3-EVK-001 that provides an easy-to-use hardware interface between the MCU and the variety of Digital 

ROHM devices in a plug-and-play fashion. For example, RKX-A3-EVK-001 is compatible with Arduino open-source hardware. Finally, the ROHM 

EVK GUI SW, a powerful Windows-based desktop application, provides an intuitive Graphical User Interface capable of displaying and logging 

the real-time device data, and configuring the device functions through a graphical register editor, to name a few. 

This user guide describes the ROHM EVK SW. For the ROHM EVK HW, please refer to the ROHM EVK HW User’s Guide. 

 

Definitions 

 

ROHM EVK Provides the full range of software, hardware and the firmware used for device evaluation purposes. 

ROHM EVK SW 
Provides the full range of the software for device evaluation purposes consisting of ROHM EVK GUI 
SW and RKX EVK FW 

ROHM EVK GUI SW ROHM device evaluation software with a graphical user interface running on Windows OS 

ROHM EVK FW Proprietary firmware running on microcontroller-based host adapters 

ROHM EVK HW ROHM EVK EVB connected to RKX-EVK-001 board 

RKX-EVK-001 RKX-A3-EVK-001 + CY8CKIT-059 Prototyping Kit 

RKX-A3-EVK-001 
Adapter board specifically designed to easily interface with the ROHM EVK Evaluation Board and 

development platforms 

Accelerometer EVB Evaluation board with an accelerometer 

ADC EVB Evaluation board with an ADC 

Board Term board itself refers to board configuration 

Host adapter board 
Refers to hardware that connects computer system to peripheral devices. The host adapter board 
requires a firmware for communication between the host adapter board and the computer. 

ROHM EVK EVB Accelerometer evaluation board or ADC evaluation board 

 

Acronyms 

 

ADC A/D Converter 

BTS Back-To-Sleep 

GUI Graphical User Interface 

PSoC Programmable SoC (System on Chip) 

WU Wake-Up 
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1 Introduction 

 

Reliability is a paramount property in integrated circuits (ICs), sensors, Power Management Integrated Circuits (PMICs) etc. During product 

development of these devices, powerful tools for testing and debugging them are needed. Many enterprises also need a specific environment 

tailored to the unique needs of their devices to verify correct behavior of their products. Showcasing the features and properties of developed 

products also requires a separate application developed for the purpose. Engineers in ROHM noticed that a generic tool capable of working with 

multiple MicroController Units (MCUs) to fulfill those needs was not available in markets and decided therefore to develop a tool of their own for 

these purposes. This is how ROHM EVK GUI SW was born. 

 

ROHM EVK GUI SW offers a single GUI and multiple MCU options to control various ROHM products like sensors, LED drivers and PMICs. The 

EVK GUI SW has another particularly advantageous property on distribution, in that adding new devices to user requires only a single configuration 

upload instead of re-installation of the whole GUI as typical to custom software. Various demo environments can be easily built on top of the GUI. 

Because of its versatile use, the GUI is used by people in various responsibilities and technical expertise from product development, quality control 

and marketing. 

 

Contents of this user guide can be divided into two parts. Sections 2 and 3 allow users to get quickly started with ROHM EVK GUI SW while 

sections from 4 to 7 contain more detailed and advanced subjects. More specifically, instructions for setting up and getting started with the GUI are 

given in section 2. Section 3 gives a quick and easy walkthrough for some of the most common ways to use the GUI. In section 4 the main 

components of the GUI, namely menubar, tabs, status bar and pop-up windows are gone through. In most cases, USB driver for the GUI is 

installed automatically. In some cases, however, manual installation is needed. Instructions for USB driver installation are given in section 5. The 

GUI is usually used in conjunction with firmware. As the firmware is regularly updated, needed procedures for firmware updates are detailed in 

section 6. Finally, answers to some commonly encountered problems with the GUI are given in section 7. 
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2 Set-up 

 

2.1 Requirements 

 

ROHM EVK GUI SW is compatible with Windows OS versions 7, 8, 10 and 11. Minimum recommended display resolution is 1920 x 1080. 

 

2.2 Installation 

 

If ROHM EVK Software has not been installed already, it can be installed by downloading the latest installer file from the ROHM Semiconductor 

website: https://www.rohm.com/support/accelerometer-evk-support 

 

Before running the ROHM EVK GUI SW, the necessary USB serial drivers must be installed (if Windows does not install these drivers 

automatically). See section 5. USB Drive Installation Procedure for details. 

 

2.3 Start with ROHM EVK GUI SW 

 

2.3.1 When you connect RKX-EVK-001 to a computer 

  

Please follow the following basic procedure to start using the ROHM EVK GUI SW: 

 

1. After the installation is completed, the application icon will be available on the Desktop (Figure 1).  

Double clicking the icon with the mouse will launch the GUI.  

 

 

Figure 1. ROHM EVK GUI SW icon  

https://www.rohm.com/support/accelerometer-evk-support
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NOTE: The application is also able to be launched from the Start–menu of Windows (Figure 2). 

 

 

Figure 2. ROHM application folder in the Start-menu of Windows 10. 

 

2. Select a suitable board from the dropdown menu (Figure 3) of the Connection status indicator or from the Board – menu (Figure 4). 

 

Figure 3. ROHM EVK GUI SW opening view 

 

      

Figure 4. Board Menu 
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3. Open the RKX-EVK-001 info -tab. 

Verify that the connecting device is same as in the image. If the image is not the same, please reselect the board. In this state the 

connection status is “EVK disconnected” ref. (Figure 8). 

 

NOTE: In this example, RKX-EVK-001 + ADC EVB are shown. 

 

Figure 5. Board Information Tab 

 

4. After the verification is done, connect your device to the computer with a micro-USB cable (Figure 6). The ROHM EVK GUI SW 

connection status indicator will change to yellow, “EVK Connected” state (Figure 5).  

See alternative methods for EVB connection from (Figure 109). 

 

 

Figure 6. A device connection with a micro-USB cable 
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5. Confirm your device by clicking the Confirm Board- button. Connection indicator will change to Green, EVK Ready status (Figure 7). 

 

 

Figure 7. Streaming view 

 

6. Go to the Plotter - tab. The data evaluation is available after pressing the Streaming button. 

 

2.3.2 Connection status indicator 

 

ROHM EVK GUI SW features a connection status indicator between the computer and ROHM-EVK-001 (Figure 8). 

1. When the GUI is launched, the status indicator will appear as “EVK Disconnected”. 

2. When ROHM-EVK-001 is connected to the computer with a micro-USB, the status will change to “EVK Connected”. 

3. After the “Confirm board” button is pressed, the status of the GUI will change to “EVK Ready”. 

 

Figure 8, ROHM EVK GUI SW Connection Status 
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2.4 Some example cases of connecting the RKX-EVK-001 

 

• Attach an Evaluation Board (e.g., BU79100G-LA-EVK-001, KX132-1211-EVK-001 etc.) to the slot J5 of RKX-EVK-001 with the 

provided ribbon cable or to the slot J6 of RKX-EVK-001 without the ribbon cable. For details refer to (Figure 108, Table 2) and (Figure 

109). 

• Connect the RKX-EVK-001 to the PC with the provided micro-USB cable (Figure 6). 

• Launch the ROHM EVK GUI SW application. 

 

2.4.1 An example for accelerometers 

 

Select the board configuration from the Board menu:  

• e.g., RKX-EVK-001 / Accelerometer EVB / I2C 

 

Select the desired configuration stream for the corresponding accelerometer sensor from the Stream menu:  

• E.g., KX132-1211 / ADP data 1600Hz Band Pass 100Hz – 200Hz with RMS 

 

NOTE: I2C interface can be used for all digital sensors but the highest Output Data Rate (ODR) will be limited to ~3400Hz.  

 

NOTE: For sensors that support SPI interface (e.g., KX132-1211, KX134-1211), select the RKX-EVK-001 / Accelerometer EVB / SPI board 

configuration that supports ODR up-to 25600Hz. 

 

• If the “Please enable streaming to activate Plotter movement!” – pop-up window appears on the screen, enable data streaming with 

the “Streaming” button. 

 

The plotter should now display real time output for ADPX, ADPY, and ADPZ also AccX, AccY and AccZ axes of the KX132-1211 sensor according 

to its movement (Figure 9). 

 

Figure 9. Plotter view with KX132-1211 motion displayed 
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2.4.2 An example for the ADC evaluation 

 

• Select the board configuration from the Board menu:  

1. e.g., RKX-EVK-001 / ADC EVB 

 

• Select the desired configuration stream for the corresponding ADC from the Stream menu:  

2. e.g., BU79100G / ADC data (VA=3.3V, 10kSPS, non-inverted) 

 

• If the “Please enable streaming to activate Plotter movement!” – Pop-up window appears on the screen, enable data streaming with 

the “Streaming” button. 

 

The plotter should now display real time output for ADC (Figure 10). 

 

 

Figure 10. Plotter view with measurements of BU79100G-LA displayed 
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3 Common use-cases 

 

ROHM EVK GUI software is used by people of varied occupational positions in numerous different ways. Some examples of the most common 

ways to use the ROHM EVK GUI SW are: 

• Examining and manipulating device registry values. 

• Monitoring device values. 

• Visual inspection of real-time measurement data. 

• Recording measurement data to a file. 

These use-cases are presented in the following subsections. 

 

3.1 Examining and manipulating device registry values 

 

One principal use for ROHM EVK GUI SW is evaluation and tuning of device registry values. In this section the tools developed for the purpose 

are gone through. If the device has an eligible internal register, the register editor tab can be used for reading and writing device register values. 

Devices with eligible registers can be selected from the “Device name” pull down menu as shown in Figure 11. 

 

 

Figure 11: Selecting device. 

 

3.1.1 Selecting shown registers 

 

Many devices contain numerous registers and going through them all may at times be laborious. Often only a small subset of registries are of 

interest. For that reason, ROHM EVK GUI contains ready-made sets of registers each grouped to represent a set of registers which share some 

fundamental property or purpose. In the following Figure 12 an example of such set containing registries related to data stream for the device is 

shown. By default, all registers of the device are displayed. 
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Figure 12 Selecting registry set.  

 

3.1.2 Editing registry values 

 

The register value can be edited by activating the desired field using left mouse button and entering decimal or hexadecimal number to it. The 

value can be edited using ‘arrow up’, ’arrow down’, ‘page up’ and ’page down’ keys. Clicking the ‘Write’ button will write the value to the device. Part 

of the registry values are edited by using the corresponding checkboxes or drop-down lists as shown in Figure 13. 

 

 

Figure 13: Editing registry values. 

 

3.1.3 Loading and saving registry values 

 

Initially, the register values of the registers correspond to the values defined in the device datasheet. These values are shown with status label of 

‘POR’ in the GUI. To see the current register’s values from the connected device, the ‘Read All’ button must be clicked to read all the registers at 

once. Similarly, all register values can be written to the connected device by clicking the ‘Write All’ button. To update and edit the value of one 

register, user may click the corresponding ‘Read’ and ‘Write’ button for the register as highlighted in the Figure 14. 
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Figure 14: Controls for reading and writing registry values. 

 

3.2 Monitoring device values 

 

In many cases it is important to monitor certain subset of device values with respect to some limit values. The ROHM EVK GUI SW offers tools 

for detection of device states based on automatic polling of registry values. 

 

3.2.1 Wake-Up detection 

 

Devices often have limited capacities and available resources. For example, some devices may consume considerably power when in active 

state, but also have significant time intervals when their use is not needed. In such scenarios it is useful for the device to ‘sleep’ consuming only 

minimum amount of power when it is not needed and then wake-up to active operation when required. The wake-up detection functionality in 

ROHM EVK GUI SW has been developed to demonstrate that feature. 

 

Wake-up related properties of devices are strongly device-dependent and therefore no universal rules for their use can be given. Usually the 

thresholds for waking-up can be selected and limit values tuned. The registry set property in ROHM EVK GUI can be useful in locating device 

settings which are wake-up related. In the following Figure 15, an example of one such registry set and one wake-up related parameter in the 

device has been given. The tooltips of ROHM EVK GUI offer useful information about the device setting properties when planning a wake-up 

functionality for a device. A commonly used abbreviation for Wake-Up functionalities in ROHM EVK GUI is WU. 
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Figure 15: Registry wake-up settings example. 

 

3.2.2 Back-to-Sleep detection 

 

Equivalent, but opposite functionality to the Wake-Up detection is Back-to-Sleep detection. For the Back-to-Sleep detection to be relevant, the 

device must be in active state. Depending on the device-specific functionalities and user-given parameters the system recognizes when conditions 

are sufficient for the device to go into sleep mode. A commonly used abbreviation for Back-to-Sleep functionalities in ROHM EVK GUI is BTS. 

 

3.2.3 Registry polling 

 

A separate, yet related service to Wake-Up and Back-to-Sleep detections is registry polling. In register polling the software automatically retrieves 

latest register values from the device registry. Registry polling is a convenient way to monitor all values of the registers.  

 

The registry polling is commenced by clicking the ‘Start’ button at the top part of the registry editor tab as highlighted in Figure 16. The default 

interval between polling calls is 10 milliseconds and can be adjusted using the ‘Polling’ edit box. The ‘Auto stop’ button, starts the polling in a mode 

that stops the register polling as soon as any value of the registers in the registry set changes. 
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Figure 16: Registry polling controls. 

3.3 Visual inspection of real-time measurement data 

 

Visual inspection of real-time sensor measurement data has been made easy in ROHM EVK GUI SW. Assuming that the software has been 

correctly installed as described in section 2, only the following actions are needed by the user: 

1. Start the GUI application. 

2. Plug in selected device. 

3. Select board. 

4. Select device stream. 

5. Examine areas-of-interest on the data. 

These phases are gone through in detail in this subsection. 

 

3.3.1 Start the ROHM EVK GUI SW application 

 

ROHM EVK GUI SW is started by clicking the icon as presented in section 2.3.1. 

 

3.3.2 Plug in your selected device 

 

One example of a system for plugging in your device is presented in the Figure 6. Discussion of the different options for device connection is 

presented in section 2.4. Once the device has been connected, the display for device connection on the right side of the GUI should change from 

the red ‘EVK Disconnected’ to the yellow ‘EVK Connected’ state as depicted in the Figure 8. 

 

3.3.3 Select board 

 

After the ROHM selected device has been plugged in, user has to select the used board as depicted in Figure 3. Visual confirmation of the choice 

can be made once the board selection has been made using the info tab containing board images as depicted in section Figure 5. Once user is 

satisfied with the board selection, the ‘Confirm’ button should be clicked on the display for device connection on the right side of the GUI, thus 

changing the system state from the yellow ‘EVK Connected’ state to green ‘EVK Ready’ as depicted in the Figure 8. 
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3.3.4 Select device stream 

 

Once the board has been selected, the board-dependent stream options are enabled. Example of the selection of device stream is given in Figure 

17. The currently selected stream is shown in the status bar as also highlighted in the figure. 

 

 

Figure 17: Stream selection. 

 

3.3.5 Examine areas-of-interests in the data 

 

After selecting the “Plotter” tab page and clicking the “Streaming” button in the upper left corner of the GUI, live streams for each available channel 

of the used device are displayed in the main GUI window. The “Sub channel view” on the right-hand side panel has a column for the digital output 

of each sub channel as highlighted in Figure 40. User can select which streams are shown by clicking the buttons in the view. The stream flows 

can be paused using the “Pause” button. 

 

Zooming for a closer look is possible by using the mouse scroll wheel or ctrl-key + right mouse button. Holding down right mouse button and 

moving the mouse changes the area shown in the zoomed view. A quick way to get a zoom level nicely fitted to the device data is to click the “Auto 

scaling” button which will scale the streams according to the minimum and maximum values in the y-axis. Zooming to an area-of-interest is shown 

in Figure 18 and Figure 19. 
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Figure 18: Unzoomed image with the zooming area highlighted. 

 

 

Figure 19: Zoomed image. 

 

The number of data points shown in the plotter can be adjusted by using the “Data range” slider bar. The “Show Grid” button displays data grid 

lines along with the data. 

 

Fourier transformation for the signal can be viewed by clicking the “FFT” button in the middle part of the button toolbar. User can also switch 

between linear and logarithmic axis in the FFT image by using the “x-axis” and “y-axis” drop-down menus. 
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Figure 20: FFT button clicked. 

 

3.4 Recording measurement data to a file 

 

One common use-case for the ROHM EVK GUI SW is to record data from some measurement device to a file. 

 

3.4.1 Saving the data to a file 

 

Saving data to a file in the ROHM EVK GUI SW requires user to do repeat the following steps: 

• Open the ROHM EVK GUI application. 

• Plug in selected device. 

• Select and confirm the used board. 

• Select the stream. 

• Click the ‘Streaming’ button. 

• Click the record button (The button with the red dot). 

When clicking the ‘Record’ button a file menu opens for selecting name and folder for the data file. A .csv file is saved to the selected directory. 

Default directory for the data file is ‘log_files’ directory in the same folder as the executable. The record button and logging remainder are 

highlighted in the Figure 21. 
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Figure 21: Record button and logging text. 

 

3.4.2 Data logging options 

 

There are usually numerous device-dependent options for the data stream. These options are configurable from the Data Stream Register Set as 

shown in Figure 22. The ‘Data Set’ subset of device configurations is selectable from the ‘Select Set’ drop-down menu highlighted in the figure. 

Once the ‘Write’ buttons or ‘Write All’ button is clicked after editing some values, the changes are sent to the device and are affecting the live data 

stream shown in the plotter. 

 

 

Figure 22: Data Stream Register Set. 

In addition to the device dependent data options user can also change the number of points shown on the plotter by adjusting the ‘Data Range’ 

slider or switching between counts and SI- units by clicking the ‘Raw data’ button. ROHM EVK GUI also contains Fast Fourier Transform(FFT) 

functionality which is turned on by clicking the ‘FFT’ button. Controls for these options are shown in Figure 23. 
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Figure 23: Point frequency, SI- unit and FFT options. 
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4 EVK GUI elements 

 

The main elements of EVK GUI are menu bar, tabs, status bar, pop-up windows and shortcuts. In the following subsections these elements are 

described in detail. 

 

4.1 Menu bar 

 

Most of the functionality of the ROHM EVK GUI SW is accessible from the menu bar. Short description of the menu items is available for most of 

them by hovering the mouse pointer on the menu items. 

 

4.1.1 File – Menu 

 

Figure 24. File menu 

The File menu contains only the option to exit the application. Selecting “Exit” will exit from the application. 

 

4.1.2 Data – Menu 

 

 

Figure 25. Data Menu 

The Data menu contains the options related to acquiring the data. 

 

4.1.2.1 Streaming 

 

The streaming menu is used for enabling / disabling device data streaming. 

NOTE: Data stream enabling / disabling may take a while, so please be patient. 

 

4.1.2.2 Logging 

 

The logging menu is used for enabling / disabling device data logging. When logging is enabled, then “logging to” text is blinking on the right corner 

of the status bar (Figure 26). 

NOTE: It is normal to see a variation in the time intervals. Data is received at varying intervals and timestamps for it are given by the ROHM EVK 

GUI SW. 

 

 

Figure 26. Status bar text when logging is active. 
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4.1.2.3 Automatic log files 

 

There are two log files will be created automatically in the case of following status: 

• “log.txt”: When ROHM-EVK-HW is connected to a PC, “log.txt” -file will be created and it will be stored in “..\ROHM_EVK_v3\ROHM-

EVK-GUI” -folder. This log file provides the version information, streaming configuration and all logged actions. 

• “errorlog.txt”: In case of an error occurrence e.g., disconnect the test device or stop Streaming, “errorlog.txt”-file will be created in the 

same folder. 

 

4.1.3 Connection – Menu 

 

The ROHM EVK GUI SW connects to the RKX-EVK-001 via a USB COM port. The Bluetooth connection (Windows BLE) is reserved for other 

host platforms supported by the ROHM EVK. The GUI uses USB COM connection by default. When auto-connect is enabled, the USB connection 

is established automatically when the RKX-EVK-001 is connected. The items in the ‘Connection’ menu are based on what is supported by the 

board configuration. The software remembers the type of last used connection. 

 

 

Figure 27. Connection Menu 

 

NOTE: Changing connection may take a while, please be patient. 

NOTE: If you are having connection problems, “CTRL + R” can be used to refresh current connection. 

 

4.1.4 Registers - Menu 

 

The Registers menu contains the functionality related to register editor and how values in the register editor are load/save from/to file or read/write 

from/to the connected device. 

NOTE: Register editor view can be found in (4.2.3 Registers – Tab) 

 

 

Figure 28. Registers Menu 
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4.1.4.1 Load register configuration from file 

 

Selecting this menu allows the user to load register configuration from file to the register editor. 

 

4.1.4.2 Save register configuration to file 

 

Selecting this menu allows the user to save the current register configuration in the register editor to a file.  

 

4.1.4.3 Read all register values from IC 

 

Selecting this menu allows the user to read all the register values from the IC to the register editor. 

 

4.1.4.4 Write all register values to IC 

 

Selecting this menu allows the user to write all of the current register values from the register editor to the IC. 

 

4.1.4.5 Dump register values to file 

 

Selecting this menu allows the user to save all the current register values from the register editor to a file (Figure 29) 

 

Figure 29. Partial Snapshot of the KX132-1211 Register Dump 

 

NOTE: The default location to save the Register Dump file is: 

\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\log_files 

NOTE: Before performing the “Register dump”, the corresponding Register definition needs to be selected (Figure 67) or loaded first (4.1.4.1 Load 

register configuration from file).  Otherwise following notification is shown (Figure 30). 

 

 

Figure 30. Register definition Loading Notification Dialog Box 
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4.1.4.6 Open register map definition 

 

Selecting this menu allows the user to load any register definition file to the register editor. Registers definitions for devices supported by the currently 

selected Board can be selected from the “Device name” pull down menu of the register editor (4.2.3 Registers – Tab). This menu is disabled if 

register is not visible. 

 

NOTE: <device name> - NOT FOUND. For example: KXTJ3 – NOT FOUND. This message means the selected device is not supported by the 

currently selected Board from the Board menu (4.1.7 Board – Menu) 

 

4.1.4.7 Verify write 

 

Checking this menu item allows the verification of the written register values by reading the values from the IC after write. 

 

4.1.5 Settings – Menu 

The settings menu contains various connectivity and functionality settings. 

 

 

Figure 31. Settings Menu 

 

4.1.5.1 Auto Connect USB 

 

When “Auto connect USB” is enabled, every time when ROHM EVK GUI SW is started, it will automatically select the USB COM port for the 

connected device and connect to it. 

 

4.1.5.2 Auto config and registers download 

 

When “Auto config download” is enabled, the ROHM EVK GUI SW will automatically check and download the latest product information. The user 

will be notified when there are new configurations available for download (エラー! 参照元が見つかりません。). 

 

4.1.5.3 Automatic streaming 

 

When “Automatic streaming” is enabled, the ROHM EVK GUI SW will automatically start data streaming when the device stream is changed. 
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4.1.5.4 COM port 

 

When there are multiple devices connected or there is some problem with the USB COM port selection, the COM port can be selected from the 

dropdown list. Before doing this the “Auto-connect” feature must be disabled. 

 

4.1.5.5 Reset connection 

 

If you are having connection problems, “Reset connection” can be used to refresh the current connection. This also initializes the current data 

stream again. 

 

4.1.5.6 Reinitialize board 

 

Reinitializes the host adapter board (and IC). 

 

4.1.5.7 Reconfigure product family 

 

The ‘Reconfigure product family’ menu option of ‘Settings’ menu enables browsing and selecting different ROHM EVK product families. The new 

product family can be selected from the ‘Product Family Selection’ window as shown in Figure 32.  

 

 

Figure 32: Product Family Selection 

 

As each product family has a separate folder in ‘Configuration’ directory of the same folder as the executable, the ROHM EVK GUI makes it 

possible to switch between different product families even when there is no internet connection available, provided that the product family has been 

downloaded earlier. If the internet connection is not available, the green ‘Update Status’ icons are replaced by red ‘X’ icons in the dialog. Assuming 

that internet connection is available, the latest update for the configuration becomes available immediately when it is published. Information of 

which product families are available for the user, of which of them the user already possesses a local package and for which of them there is an 

update available is presented in the ‘Product Family Selection’ window as highlighted in Figure 32. Updates are downloaded automatically for a 

product family when the product family is selected from the ‘Product Family Selection’ window.  
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4.1.5.8 Host adapter board programmer 

 

A board configuration developed for Cypress must be selected and the system must be either in ‘EVK connected’ or in ‘EVK ready’ state, (as 

described in Section 2.3.2) for the ‘CY8CKIT-059 board programmer’ menu item to be visible. Using the ‘PSOC5 Programmer’ enables updating 

firmware for CY8CKIT-059 using ROHM EVK GUI SW. Choose the correct update file by clicking the ‘…’ button followed by clicking the ‘Program’ 

button as highlighted in Figure 98. The ‘Filters’ button is only to be used when the EVK GUI SW is in the wrong connection status and is normally 

not needed. 

NOTE: The firmware update file is located in the ROHM-EVK-Firmware\CY8CKIT-059 folder. 

 

 

Figure 33: PSOC5 Programmer menu. 

 

4.1.6 Stream - Menu 

 

The Stream menu can be used to pre-configure applicable devices to operate in certain modes. It can also be used to define how data is received 

or processed from other devices. The list of streams is dynamic and will change according to the chosen board configurations (4.1.7 Board – 

Menu). For example, if the RKX-EVK-001 / Accelerometer EVB / SPI board configuration is selected from the Board menu, the KXTJ3 sensor will 

not be shown in the Stream menu because it does not support an SPI interface. However, when the RKX-EVK-001/Accelerometer EVB/I2C board 

configuration is selected, the KXTJ3 sensor will be shown (Figure 34). 
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Figure 34. RKX EVK GUI SW sensor stream menu 

 

In the case of BU79100G-LA-EVK-001, the stream menu (Figure 35) can be used to pre-configure the device to operate in a specific mode.  

 

 

Figure 35. ADC data streaming menu 

 

NOTE: The ROHM EVK GUI SW will store the last used stream configuration and it will be loaded in the next application startup. 

 

4.1.7 Board – Menu 

 

The board menu is used for selecting the EVK HW what is going to be used. For ADC evaluation, the available board configuration is limited to 

the” RKX-EVK-001 / BU79100G-LA-EVK-001 ADC” (Figure 37). For sensor evaluation, the ROHM EVK GUI SW supports multiple host adapters 

(Arduino UNO R3, CY8CKIT-059 Prototyping Kit, nRF52840-DK) – and each in turn supports one or two communication interface protocols (I2C, 

SPI). The correct board configuration must be selected based on the host adapter used and the communication interface protocol supported by 

the sensor that is being evaluated.  

NOTE: The Board menu lists either all supported board configurations for all supported Host Adapters (Figure 37) or only the relevant ones (Figure 

36) that are supported by the Host Adapter currently plugged in, e.g., CY8CKIT-059 / RKX-A3-EVK-001 / that comes with the ROHM EVK package 

by default. The selection is done via the View menu (4.1.8 View – Menu). 

 

Wake-up & back-to-sleep  
detection streams 
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Figure 36. The Board Menu when “Show all board configurations” is not selected 

 

 

 

Figure 37. The Board menu when “Show all board configurations” is selected 

 

The default board configuration is “RKX-A3-EVK-001 /Accelerometer Module / I2C”. 

For ADC, the available board configuration is limited to the” BU79100G-LA-EVK-001”. 

4.1.8 View – Menu 

 

The View menu item provides different features that can be shown or hidden in the ROHM EVK GUI SW. 

 

 

Figure 38. View Menu 

 

For sensor evaluation (e.g., KX132-1211), if “wake-up & Back-to-Sleep Detection streaming” is selected (Figure 34) the “Show wake up pop 

window” is visible in the View -menu accordingly (Figure 39). 
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Figure 39. View menu with Show wake up pop up window 

 

4.1.8.1 Digital output in sub channel view 

 

The “Sub channel view” is located on the right-hand side panel and it is always visible when some device stream is activated. This view is not 

shown if the current board configuration has no device streams. The “Sub channel view” has a column for the digital output of each sub channel 

which can be enabled with the “Digital output in sub channel view” submenu. 

NOTE: Available sub channel views are always related to the used device stream and the data channels inside of it.  

NOTE: When you have a very high ODR (12.8 kHz or 25.6 kHz), the digital output can slow down the performance. (4.4.3 ODR has not reached 

the target value pop-up window)  

 

 

Figure 40. Plotter view with Sub Channel View and Digital Output Enabled 
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The ADC channel view 

 

Figure 41. Plotter view of ADC data with Sub Channel View and Digital Output Enabled 

 

It is possible to select which channels are enabled by pressing on the channel name. For example, for a default stream such as Accelerometer 

data 50Hz ±2g high performance of the KX132-1211, in order to monitor the accelerometer’s Z axis only, press once on AccX and AccY to disable 

these channels. The only remaining channel would be AccZ as shown in (Figure 42). 

 

 

Figure 42. Plotter view with only AccZ sub-channel activated 

 

4.1.8.2 Events view panel 

 

When the Events view panel is enabled from the View menu the events will be show in the output window located below the plot window. 

(Figure 43).  
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Figure 43. Events view panel output window 

 

4.1.8.3 Reference line 

 

When the “Reference line” is enabled, the plotter shows an additional horizontal line that can help to compare the real time signal value against 

the referenced value (Figure 44). The line can be dragged up/down the plotter view by pressing and holding the left mouse button. The present 

value of the Reference line position is also shown in the Status bar (lower right corner of the window). To achieve a higher resolution / granularity 

when setting the reference line position, use the mouse scroll wheel to zoom into and out of the plotter window. 

 

 

Figure 44. Plotter view with reference line enabled 

 

4.1.8.4 Show all board configurations 

 

The “Show all board configurations” sub menu item controls whether the Board menu item lists all supported board configurations for all supported 

Host Adapters or only the relevant ones that are supported by the Host Adapter currently plugged in (4.1.8 View – Menu). 
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4.1.8.5 Show ODR warning pop up window 

 

The ODR warning pop-up window appears anytime the real time Output Data Rate (ODR) as measured by the ROHM EVK GUI SW is 

significantly different from the nominal ODR set in the Stream (Figure 83). 

 

4.1.9 Help – Menu 

 

 

Figure 45. Help Menu 

 

4.1.9.1 User Guide 

 

Selecting “User Guide” opens the ROHM-EVK-Docs- folder, where you can find the hardware guide, “ROHM EVK HW User’s Guide”, as well as 

the software guide, “ROHM EVK SW User’s Guide”. 

 

4.1.9.2 Release Notes 

 

Selecting “Release notes” opens the release notes-text file, where details of the version release are explained. 

4.1.9.3 About ROHM EVK 

 

The “About ROHM EVK GUI SW” help menu shows the current GUI’s version information. It also shows the link where the latest version can be 

downloaded from (Figure 46). 

 

 

 

Figure 46. About ROHM EVK GUI SW 
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4.1.9.4 About Host Adapter Board 

 

The “About Host Adapter Board” help menu shows the current connected ROHM EVK HW and ROHM EVK FW information. (Figure 47). 

 

 

Figure 47. About Host Adapter Board Information menu for the CY8CKIT-059 Prototyping Kit 
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4.2 User Interface - Tabs 

 

The functionalities of the ROHM EVK GUI SW are divided between separate tabs and all tabs are dockable facilitating simultanoues use of different 

tabs as shown in Figure 48. 

 

 

Figure 48: Dockable tabs. 

 

4.2.1 Plotter – Tab 

 

The Plotter in (Figure 9 and Figure 10) shows device data from the current stream. The Plotter tool bar has its own Streaming and Raw data 

buttons to enable quick changing between the two (Figure 49).  

 

 

 

Figure 49. Plotter tool bar 

Toolbar has following functionality: 

• Streaming: enables / disables data streaming 

• Data logging: enabled/disabled with the button with a red circle icon. 

NOTE: When logging is enabled the red circle icon starts to blink. 

• Raw data: toggle stream data between counts and SI-units (4.2.1.1) 

• Auto scaling: plotter will auto scale the minimum and maximum values in the y-axis according to the device data. 
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• Show grid – enables data grid lines. The shortcut ”G” can also be used for this. 

NOTE: This may slow down the plotter’s performance. 

• Pause – pauses the plotter. The shortcut “P” or left mouse button can also be used for this. 

• Clear – clears all data points from the plotter. The shortcut “C” can also be used for this. 

• FFT – turns on the Fast Fourier Transform (FFT) functionality of the plotter. More information can be found in (4.2.1.4. Frequency 

analysis). 

• Data range – this slider bar adjusts the amount of data points shown in the plotter.  

NOTE: At high data rates, the slider area of Data Range may flash red, indicating that it is unable to draw all the samples received. The 

data will be averaged in order to fit into a screen. 

 

The plotter tool bar has also dynamic buttons at the right. These dynamic buttons are created according to the device stream data channels. 

By using these buttons, the user can show/hide data channels within the used device stream. For example, for the KX132-1211 sensor, for all data 

streams that start with ADP (Advanced Data Path), there are two dynamic buttons - Advanced Data Path and Accelerometer - that can be toggled 

to show / hide ADP and Raw Output Data streams respectively (Figure 50). 

 

 

Figure 50. Plotter tool bar dynamic buttons 

4.2.1.1 Raw data 

 

When raw data is disabled, data is shown in SI units: 

 

 

Figure 51. Data stream in SI units 

NOTE: If the full-scale range of the device has been modified in the Stream modify mode (4.2.3.4 Stream modify mode), e.g., g-range of the 

accelerometer, then the SI unit values displayed in the plotter view and in the Digital Output view channel will be incorrect. 
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For ADC streaming, “inverted” settings are available only when raw data is disabled. 

 

Figure 52. ADC data in SI units (V) 

4.2.1.2 Zooming 

 

You can zoom in and out using the mouse scroll button or the right mouse button + CTRL. 

NOTE: When you perform zooming, while “Auto scaling” is enabled, the Plotter will terminate auto scaling. 

In order to use Auto scaling after zooming, the “Auto scaling” - button must be activated again. 

 

4.2.1.3 Moving 

 

The position of the Data axis (y-axis) can be moved up and down using the right mouse button. 

 

4.2.1.4 Frequency analysis 

 

The Plotter also has an FFT (Fast Fourier Transform) functionality to show frequency data. The sub-channel view can be used to show only the 

desired sub-channel frequency graph(s) and to further narrow down to any specific axis if required. For instance, (Figure 53) shows the input signal 

sensed by KX132-1211 accelerometer which has two frequency components, 300Hz and 600Hz. The plotter is configured to show only data for 

accelerometer Z-axis (AccZ), with logarithmic scale on Y-axis.  

FFT data can be shown also from ADC Evaluation board data. Example FFT data of a sine wave with a frequency of 200 Hz input to ADC 

Evaluation Board. In addition, it is possible to change the x-axis to a logarithmic scale and the y-axis to a dB scale. 

NOTE: The x-axis range for the plot starts from 0 Hz and ends in ODR/2 Hz. It is automatically adjusted if the ODR is modified. 

 

 

Figure 53. Plotter view of KX132-1211 with FFT functionality 
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Figure 54. ADC plotter view with FFT functionality 

 

 

 

Figure 55. Plotter view with FFT functionality (logarithmic and dB scale) 

 

4.2.1.5 Advanced Data Path (ADP) 

 

Advanced Data Path (ADP) is a special ASIC level functionality available only for the KX132-1211 / KX134-1211 accelerometers, which consists 

of three blocks including a configurable second order low-pass filter, first order low-pass or high-pass filter, and an RMS calculation engine. The 

user can configure each stage of the ADP individually or they can be bypassed with the corresponding register settings using the register editor. 

The output of the ADP engine can be monitored with the Plotter by viewing the Advanced Data Path channel.  

 

To review the ADP functionality further, consider the example FFT signal shown in (Figure 39) and FFT signal from ADP output shown in (Figure 

56). In these examples, the selected stream for the KX132-1211 sensor is ADP data & WUF/BTS Detection 1600Hz Band pass 200Hz-400Hz 

with RMS. The Advanced Data Path is configured to band-pass filter topology with the signal bandwidth set from 200Hz to 400Hz. From (Figure 

56) it can be seen that the band pass filtered signal produces a 10dB attenuation at 600Hz. The output is then routed to the RMS engine and then 
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to the Wake-Up/Back-to-Sleep engines. The wake-up threshold is set to 48 counts, and the Wake-up counter is set to 5 counts. When raw data 

(1.4.1.1 Raw data) is disabled the selected data stream will scale ADP output directly to the values (unit is WUF/BTS Threshold). The Reference 

line is also moved to the wake-up threshold level (48) for easier comparison of the threshold value and the ADP output value (1.3.8.3 Reference 

line) Also, the Wake-up pop-up window is enabled (4.4.4 Wake up pop-up window). The pop-up window will appear when a wake-up event is 

active, e.g., when a signal within band-pass frequency range is present (Figure 57). 

 

 

Figure 56 Plotter view of KX132-1211 with FFT functionality (ADP channel) 

If there is a need to change the threshold values, then the proper threshold values can be seen from the plotter view and then written to the sensor 

using the register editor see (4.2.3.4Stream modify mode) for details.  

 

 

Figure 57. The plotter view with ADP & WUF data stream 
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4.2.2 Angle Calibration – Tab  

 

The Angle Calibration tab is visible when Inclinometer stream is selected. For example, for the KX132-1211 there is a stream called “Inclinometer 

100Hz ±2g” (high perf) as shown in (Figure 58). 

 

 

Figure 58. Angle Calibration Tab 

 

The Angle Calibration tab allows the user to calibrate the sensor for evaluation purposes with the ROHM EVK GUI SW. Note that calculated 

parameters are not saved to the sensor itself. The user can start a new calibration by clicking the start button and by executing following steps 

while streaming is active. 

 

NOTE: If ROHM EVK GUI SW detects that calibration has been done on the same calibration position twice in a row, the Calibration Error window 

will appear, and the user will be required to restart the calibration procedure from the 1st calibration procedure (Figure 59). 

 

 

 

Figure 59. Angle Calibration Error Message 

 

1. Put the device in the 1st calibration position as displayed in the orientation diagram (Figure 60). Tip: if Accelerometer EVB is used, the 

X/Y/Z orientations are printed on the back side of the board. The current values (in counts) for X and Y axes are displayed in the table 

right under the orientation image. 
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Figure 60. Angle Calibration. Position - 1 

 

2. Click Next and hold the device still until the diagram changes to the 2nd position (Figure 61) The last current value for position 1 is now 

stored and shown in the 2nd table. 

 

 

Figure 61. Angle Calibration. Position – 2 
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3. Click Next and hold the device still until the diagram changes to the 3rd position (Figure 62) 

 

 

Figure 62. Angle Calibration. Position – 3 

 

4. Click Next and hold the device still until the diagram changes to the 4th position (Figure 63) 

 

 

Figure 63. Angle Calibration. Position - 4 

 

After the 4th calibration position is finished, the orientation figure returns to the 1st position. The Inclinometer calibrated status will appear in the 

right corner of the status bar (Figure 64), and a small desktop notification message will appear for a few seconds to indicate that the calibration 

procedure is done (Figure 65). 
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Figure 64. Angle Calibration Completed. Back to Position 1 

 

 

Figure 65. Calibration Done notification window 

 

At this point, if the user is satisfied with the calibration parameters, they can be saved to an individual .json file that can be loaded next time the 

ROHM EVK GUI SW restarts. These calibration parameters will now be used for angle calculations. The plotter view now shows the Accelerometer 

(X, Y, Z) acceleration data stream as well as the angle stream. The default units for angle values are radians. To display the angle information in 

degrees, click on the Raw data button located above the plotter view (Figure 66). 

 

  

Figure 66. Plotter view with KX132-1211 inclinometer stream 
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4.2.3 Registers – Tab 

 

If the device has an eligible internal register, the register editor tab can be used for reading and writing device register values (Figure 67).  

All the devices of the selected board, which have eligible registers can be selected from the “Device name” pull down menu. 

 

 

Figure 67. ROHM EVK GUI SW register editor tab 

 

NOTE: When the device register is selected from the pull-down menu, the name of the tab will change to one of the following: 

• <device name>. For example: KX132-1211. This means the Register editor was entered while the Streaming is not active. 

• <device name> - MODIFYING STREAM. For example: KX132-1211 - MODIFYING STREAM. This means the Register editor was 

entered while the Streaming was enabled (4.2.3.4 Stream modify mode). 

 

NOTE: When a new device in the register tab is opened, the register’s content shows the POR values of the registers as defined in the device 

datasheet. In order to see the current register’s values from the connected device, press the Read All button to read all the registers at once or the 

Read button, to read the value of an individual register. 

 

NOTE: Status column indicates the present status of connected sensor. The status can be POR(Power of Rest), Error, Read, Stored, Changed, 

Unchanged or Write Fail, depend on the circumstance of the editor functions.  

 

4.2.3.1 Updating register value 

 

The register editor provides an intuitive way to update the values of certain bits and entire registers. The register value can be modified by activating 

the desired field by the left mouse button and enter decimal or hexadecimal number. The register value also can be edited using with following 

keys; arrow up / arrow down will increase / decrease values by 1, and Page up / Down keys changes current value by 10. The Enter - key as well 

as Write button will write the value to the device. 

 

Single Bit Function 

When an individual bit defines a certain function, the value of the bit can be changed by checking / unchecking the check box (e.g., PC1 bit of the 

KX132-1211 that sets the part in operational or standby mode). When a selection is made, click on the Write button to write the setting to the device 

(Figure 68). 
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Multiple Bits Function 

Some bits are grouped together if they make up one setting and have a predefined function for each combination of bits. For example, the Full-

Scale range of the KX132-1211 accelerometer is defined by the value of GSEL1 and GSEL0 bits. These two bits are grouped together in the 

register editor as GSEL and the user can select the actual function, instead of modifying the individual bits. When selection is made, click on the 

Write button to write the setting to the device. 

 

Reserved Bits 

If the bit is grayed out, it means it is reserved and thus the register editor does not provide a way to modify it to avoid unexpected behavior. For 

example, bit 1 in CNTL1 register is reserved (Figure 68).  

 

 

Figure 68. CNTL1 register of KX132-1211 

 

Writing to an 8-bit register 

Certain functions of the device can span across the entire 8-bit register and their value is between 0 and 255 (Figure 69). Other functions can take 

less than the full 8-bit register. For example, the FTDH value is a 5-bit value and is between 0-31 (Figure 70). In order to change the value, the user 

can simply enter the value either as a decimal or as a hex value (the hex format is 0xFF) and press the Enter key. Once the value is written, the 

“value” field of the register gets updated with the new value. It is possible to read the value back. Also, if the “Events view panel” function is enabled 

in the View menu (4.1.8.2 Events view panel) the write information will be shown in the events window. 

 

 

Figure 69. WUFC 8-bit value (0-255) 

 

 

Figure 70. FTDH 5-bit value (0-31) 

 

Changing device settings that spans over two registers 

Some functions of the device may span more than 8-bits and are thus split between 2 or more registers. For example, the WUFTH function of the 

KX132-1211 is an 11-bit value (0 to 2047). The lower 8 bits are stored in the WUFTH register (0x49), and the upper 3 bits in the BTSWUFTH 

register (0x4A) (Figure 71). 

 

 

Figure 71. WUFTH 11-bit value (0-2047) spanned across two registers 

 

To simplify the register update, the user can write the entire value to the lowest byte register (e.g., a value from 0 to 2047 to WUFTH_L register), 

and the register editor will update both registers accordingly. For example, to set the WUFTH value to 950 (0x03B6), write 950 to the WUFTH 

register 0x49, and the register WUFTH (0x49) will store the value 0xB6, while the register BTSWUFTH (0x4A) will store the value 0x03.  
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NOTE: The lowest byte register will usually show the full value in the bit field. However, the 8-bit register value field will show the actual 8-bit value 

of the register. 

NOTE: When write-command is executed to the lowest byte register, the 8-bit register value field of the lowest byte register will be updated to show 

the new value automatically. However, the 8-bit register value field of the upper register(s) that contain the remaining bit(s), will not be updated 

automatically to display the new value until the Read button is pressed.  

 

Changing device settings that occupy two or more registers 

There are some device settings that not only span over few registers, but also use those registers exclusively for this setting. In those cases, the 

Register editor hides all but the one byte and gives the user the ability to update the entire value from a single write to the single register. Consider 

the ADP_F1_BA settings of the KX132-1211 accelerometer. This setting is a 23-bit value (0-8388607) and spans across registers ADP_CNTL4 

(0x67) – ADP_CNTL6 (0x69) (Figure 72).  

 

 

Figure 72. 23-bit value ADP_F1_BA is updated from a single 8-bit register 

 

The user has the ability to update the entire 23-bit value through write to the ADP_CNTL4 register that stores the lowest 8 bits of the 23-bit value. 

 

NOTE: The one-byte register will always show the full value in the bit field. However, the 8-bit register value field will show the actual 8-bit value of 

the register. 

 

4.2.3.2 Register sets 

 

The list of registers shown in the Register tab can be defined by the register set files. Each set file lists the register addresses of the registers in the 

set to be later displayed. The ROHM EVK GUI SW comes with several pre-defined registers sets that can be selected from the “Select set” drop 

down box (Figure 73). The default register set available for all devices is the “Show all” that lists all the registers supported by the current device. 

All other register sets are defined in the corresponding register set files.  

 

 

Figure 73. Select set Drop Down Menu 

 

The register sets are a very useful feature of the ROHM EVK GUI SW as it allows the user to visually see only the registers of interest grouped 

together. Consider the Data Stream register set shown in (Figure 74). From this set, it is possible to select all the basic configurations of the 

accelerometer such standby/run mode, power mode, ODR, full scale range, and set some basic interrupts.  
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Figure 74. Data Stream Register Set 

Register Set File Location: 

The register set files are text files. The default register set files are stored together with the stream configuration files for each board configuration. 

For example, for the RKX-EVK-001, the list of register sets can be found in the following two folders (one for I2C and one for SPI serial interface 

protocol): 

..\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\Configuration\Rohm-Sensors-AFE\stream_config 

\board_05SENSORS_8_RKX-EVK-001_i2c_0 

..\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\Configuration\Rohm-Sensors-AFE\stream_config 

\board_05SENSORS_8_RKX-EVK-001_spi_1 

 

The custom register set files can be created and stored in the dedicated user folder where they will be loaded together with the default register 

sets: 

..\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\SensorSet 

 

Register Set File Naming Convention: 

The register set file name follows the following naming scheme:  

<device name>_<set name>_set.txt 

 

For example, the Data Stream for KX132-1211 sensor is called: 

KX132-1211_Data Stream_set.txt 

 

Register Set File Structure Convention: 

The register set definition follows the following scheme: 

<Set Name>:Reg1,Reg2,Reg3 

 

NOTE: the set name can contain a space. The set name should be then followed by a colon “:”-sign and HEX addresses of the registers each 

preceding by “0x” in front of it. The registers should be separated by commas and spaces are not allowed. Any register preceded by a space will 

not be shown in the register view. The registers can be listed in any order and will be sorted automatically in the register viewer from lowest to 

highest regardless of the order in the register set file. An example of the Data Stream register set is shown in (Figure 75). 
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Figure 75. KX132-1211 Data Stream Register Set 

 

NOTE: The ROHM EVK GUI SW loads all the register sets on startup. If changes were made to the content of the register set files or new register 

set files were created, the changes will be visible the next time the program is loaded. 

 

4.2.3.3 Register polling function 

 

Register polling (i.e., reads) is a simple way to monitor the values of the registers defined in the Register sets (4.2.3.2 Register sets). The Polling 

feature is enabled with the Start button (Figure 74). A delay between successive register reads can be set as well (the default delay is 10 ms). The 

polling can be stopped with the Stop button (Figure 76). Also, the polling feature has an “auto stop” – checkbox, which stops the register polling as 

soon as the value of any of the registers in the register set changes. The register polling continues when the Start button is pressed again. The 

below example shows how to monitor Wake-Up / Back-to-Sleep detection: 

• Select sensor KX132-1211 from "Device Name" pull down menu. 

• Select set “WU BTS Settings” register set from the “Select set” pull down menu. 

• Press the “Read all” button. 

• Make sure that  PC1 and DRDYE bit checkboxes are unchecked in the register CNTL1 (0x1B) and press Write. 

• Set WUFE and BTSE bit values to ENABLED in CNTL4 (0x1E) register and press Write. 

• Check MAN_SLEEP bit box in CNTL5 (0x1F) register and press Write. 

• Write 5 to the BTSC (0x4C) register to set the back-to-sleep counter to 100 msec. 

• Write 5 to the WUFC (0x4D) register to set the wake-up counter to 100 msec. 

• Check the Power Control bit (PC1) in CNTL1 (0x1B) register to enable the sensor and press Write. 

• Select “Interrupts” register set from the “Select set” pull down menu  

• Press the “Start” button from “Polling”  

 

Shake the device and monitor the status of the Wake-Up Function Status (WUFS) and Back-to-Sleep Status (BTS) bits in INS3 (0x18) register as 

well as the WAKE bit in the STATUS_REG (0x19) register. When the device is shaken above the 0.5g threshold, the “Wake” bit is asserted to 

indicate the wake state. Once the device is left in place and acceleration drops below 0.5g, the WAKE bit will be de-asserted to indicate the Sleep 

mode (NOTE, if “Auto stop” was enabled, the polling will stop on the WAKE event and needs to be restarted to see the back-to-sleep event). The 

WUFS and BTS bits values will be changing for a brief period when the corresponding interrupt has fired and stay on until they are auto cleared 

through INT_REL register auto read (Figure 76).  

NOTE: Streaming and logging are automatically paused when register polling is started. 
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Figure 76. Wake-Up / Back-to-Sleep Interrupt Detection Register Set 

 

4.2.3.4 Stream modify mode 

 

When the Register editor tab is selected while Streaming is enabled, the register editor will enter a data stream modify mode as indicated by the 

name of a Register (e.g., KX132-1211). This mode offers the user a way to change the registers which will influence the data stream itself. When 

the desired register changes have been made, the tab name will be changed with the additional text “MODIFYING STREAM”, (e.g., KX132-1211 

– MODIFYING STREAM) (Figure 77). When the user has switched back to the Plotter tab, Streaming continues with the modified register values. 

This makes it easy to change the ODR or data range for example. 

 

 

Figure 77. Register editor view in the Stream Modify Mode 

 

NOTE: Streaming and logging is automatically paused once the Register editor tab is selected. 

NOTE: Some devices require that the power control bit (PC1) be set to 0 before changing the register values. Otherwise, the register value changes 

are not applied. After registers are edited, the PC1 bit must be set back to 1 to enable the device again.  

NOTE: When switching to the Plotter view, do not press the Streaming button again. When the Streaming button is disabled and enabled again, 

the default registers values as set in the stream configuration will be written to the device! 
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NOTE: When a full-scale range of the device is changed (e.g., g-range of the KX132-1211 accelerometer), the SI units (m/s^2) will not be shown 

correctly in the plotter view and the Digital Output sub-channel view (4.2.1.1 Raw data). The counts value is not affected. 

NOTE: When registers have been changed, “(MODIFIED)” text will be shown after the stream name in the Plotter View area (Figure 78). 

NOTE: When ODR value has been changed through the register editor, the “ODR has not reached the target value” pop-up message may appear 

because the new real-time ODR is significantly different from the original ODR value defined in the stream (Figure 78). The ODR pop-up message 

can be disabled through the View menu (1.3.8. View - Menu) 

 

 

Figure 78. The Plotter View After Modifying the Register Values 

4.2.4 Info – Tab 

 

Some basic information about the selected board is shown in ‘Info’- tab as shown in Figure 79. 

 

Figure 79: Info tab 
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4.3 User Interface - Status bar 

 

 

Figure 80. Status bar 

 

The status bar shows the following information: 

• Current connection interface (USB / Bluetooth) (4.1.3Connection – Menu) 

• COM port (4.1.5.4 COM port) 

• The status of the communication (Streaming, Connected, Disconnected, No Data) 

• Real-time Output Data Rate (ODR) information 

• Selected Stream (4.1.6 Stream - Menu) 

• Selected Board (4.1.7 Board – Menu) 

• Reference line value (4.1.8.3 Reference line) 

• Angle calibration status for select streams (4.2.2 Angle Calibration – Tab) 

NOTE: Bluetooth communication is not supported by the RKX-EVK-001. 

NOTE: It is normal to see a slight variation in the ODR value. Data is received at varying intervals and the ODR is calculated when ROHM EVK 

GUI SW receives the data from the used connection layer. 

 

4.4 User Interface - Pop-up windows 

 

The application makes use of pop-up windows to notify the user about important actions. This section provides detailed information about pop-up 

windows. 

 

4.4.1 No data pop-up window 

 

“No data received” pop-up window (Figure 81) appears when streaming has been started, but no data is received. The problem could be an invalid 

board configuration selection or some connection problem (7.1.1.1 “Status: EVK Disconnected” in ROHM EVK GUI SW Status Bar  for details). 

 

 

Figure 81. No data pop-up window 

4.4.2 Streaming pop-up window 

 

Streaming pop-up window (Figure 82) appears in the Plotter view to notify the user about data stream enabling. Streaming can be enabled with 

the specific “Streaming” – button, from Data/Streaming – menu or with the shortcut “CTRL + S”. It also possible to enable Automatic streaming 

(4.1.5.3 Automatic streaming) 

 

 

Figure 82. Streaming pop-up window 
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4.4.3 ODR has not reached the target value pop-up window 

 

 

Figure 83. ODR information window 

 

The ODR warning pop-up window (Figure 83) appears anytime when the real time Output Data Rate (ODR) as measured by the ROHM EVK 

GUI SW is significantly different from the nominal ODR set in the Stream (Figure 84). This can happen, for example, when the selected ODR is 

greater than 3200Hz and the interface protocol is I2C and not SPI. This can also occur when the USB cable is either damaged or of a low quality. 

This can also occur when the ODR value has been modified through the Stream Modify Mode (4.2.3.4 Stream modify mode). 

 

 

 

 

Figure 84. Real-time ODR is significantly different than the nominal ODR. 

 

4.4.4 Wake up pop-up window 

 

 

Figure 85. Wake-Up Interrupt pop-up window 

 

The “Wake up pop-up window” (Figure 85) appears for selected wake-up / back-to sleep event detection streams (Figure 34). When a wake-up 

event is detected, the pop-up window is displayed in the plotter (Figure 86).  

 

NOTE: It is recommended to use SI units in Plot in order to better visualize the Wake-up Direction line changes. 

 

NOTE: The Wake-Up Interrupt pop-up window that is displayed can be replaced with any custom image instead of the original file. The new image 

file must be called wakeup.png, have an approximate size of 380 x 190 pixels, and be placed in the ROHM EVK GUI SW Resource folder: 

 

..\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\Resources 
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Figure 86. The plotter view with wake up triggered 
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4.5 Shortcuts 

 

The ROHM EVK GUI SW has many keyboard shortcuts: 

 

CTRL + L Enable/disable logging 

CTRL + S Enable/disable streaming 

CTRL + R 
Reset used connection and data streaming (disconnect and connect when having connection problem). Re-
enable the Streaming when connection is established. 

CTRL + E Show events view 

CTRL + D Show digital output in sub channel view (works only if subchannel view is enabled) 

C Clears the current points in plotter view 

CTRL + B Show all board configuration 

CTRL + O Show ODR warning pop up window 

G Shows the grid in the plotter   

P Pause plotter 

CTRL + W Hide/show wake up interrupt pop up window 

SHIFT + L Hide/show reference line 

CTRL + SHIFT + D Register dump 

CTRL + SHIFT + V Verify write 

CTRL + SHIFT + B Reinitialize board (re-execute board initialization messages) 

 

Table 1. Shortcuts 
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5 USB Driver Installation Procedure 

 

Before connecting the RKX-EVK-001 to a computer, it is highly recommended to install the ROHM EVK GUI SW first by using the installer file 

available for download on the ROHM Semiconductor website: 

 

https://www.rohm.com/support/accelerometer-evk-support  

 

If the ROHM EVK software installer is used, a separate USB driver installation for the Infineon CY8CKIT-059 Prototyping Kit is not required. Also, 

the Windows 10 and 11 operating systems should automatically use the correct USB driver. However, earlier Windows versions are not able to 

automatically find the CDC ACM driver and the user will need to install the signed release inf file as described below. 

 

The installation prodcedure: 

1. Following the installation of the ROHM EVK software, locate the folder “cdc_acm_driver” on the computer in the following location: 

 

..\Documents\ROHM_EVK_v3\ROHM-EVK-Firmware\Windows-dependencies\ROHM-EVK-USB-driver\cdc_acm_driver 

 

and verify the presence of the following two files in the above-mentioned directory 

 

• A file with ”.cat” extension 

• A file with ”.inf” extension 

 

2. Connect the Infineon CY8CKIT-059 Prototypic Kit to a computer using the provided micro-USB cable (Figure 87). 

 

 

Figure 87. RKX-EVK-001 connected to PC (connection to the evaluation board is optional in this step)  

https://www.rohm.com/support/accelerometer-evk-support
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3. Open the Device Manager where you should find the “Evaluation Kit (Cypress)“, as in Figure 88. 

 

 

Figure 88. Device Manager View 

 

4. Right-click the “Evaluation Kit (Cypress)” item, and choose “Update Driver Software …” A new window should open. Select “Browse my 

computer for driver software” (Figure 89). 

 

 

Figure 89. Update Driver Software - 1 
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5. Select “Let me pick from a list of device drivers on my computer”, as shown in Figure 90. 

 

 

Figure 90. Update Driver Software – 2 

 

6. Choose “Next” (the selection in the list does not matter), as highlighted in Figure 91. 

 

 

Figure 91. Update Driver Software - 3 
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7. Choose “Have Disk” (Figure 92). 

 

 

Figure 92. Update Driver Software - 4 

 

8. The installer should install the required files. If this kind of a pop-up window (Figure 93) appears, please proceed forward by selecting 

“OK”. You will be returned to an older pop-up window where you should select “Next” (Figure 94). 

 

 

Figure 93. Update Driver Software - 5 
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Figure 94.Update Driver Software – 6 

 

9. Windows will prompt you to install the driver, please select “Install” (Figure 95). 

 

 

Figure 95. Update Driver Software – 7 

 

10. Finally, please wait until the driver installation is complete. 
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6 Firmware 

 

When the Infineon CY8CKIT-059 Prototyping Kit is supplied as part of the RKX-EVK-001, it will come pre-loaded with the ROHM EVK Firmware 

to interface with ROHM EVK GUI SW. To flash the latest ROHM EVK Firmware to the CY8CKIT-059 Prototyping Kit please follow one of the 

procedures outlined in following section 6.1. 

 

6.1 Firmware Update for CY8CKIT-059 

 

6.1.1 Update using ROHM EVK GUI SW 

 

Updating firmware for CY8CKIT-059 using ROHM EVK GUI SW contains the following phases: 

1. From the ‘Settings’ menu, open the bottommost menu item named ‘… programmer’ as depicted in Figure 96. 

 

 

Figure 96: Programmer menu item. 

 

2. Check the ROHM EVK GUI goes to ‘Disconnected’ connection status, as shown in Figure 97. 

 

 

Figure 97: Checking EVK GUI SW connection status. 

 

 

 

 

 

 

3. Choose the correct update file by clicking the ‘…’ button as highlighted in Figure 98.  
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Figure 98: PSOC5 Programmer menu. 

4. Click the ‘Program’ button, as also highlighted in the Figure 98. 

5. Check that the ‘Verification succeeded’ message can be found in the PSOC5 Programmer status log as shown in Figure 99 and the 

update is complete. 

 

Figure 99: PSOC5 Programmer status log. 

 

6.1.2 Update using Infenion PSOC Programmer 

 

Updating firmware for CY8CKIT-059 using Infenion PSOC programmer contains the following phases: 

 

1. Download and install the PSoC Programmer (Windows) from Infineon’s website: 

NOTE: You need to obtain Infineon’s account from Infineon’s website. 

 

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.psocprogrammer 

 

 

 

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.psocprogrammer
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2. Following the installation of the ROHM EVK software, locate the CY8CKIT-059 folder from the computer in the following location:  

..\Documents\ROHM_EVK_v3\ROHM-EVK-Firmware\CY8CKIT-59 

and verify the presence of a ROHM EVK Firmware file with the extension ”.hex”. 

 

3. Connect the CY8CKIT-059 Prototyping Kit into the USB port of the PC directly or with an USB extension cable A-Male to A-Female as 

shown in Figure 100. 

NOTE: that firmware flashing is always done via a USB-A PCB connector, not a micro-USB connector on the other side of the board. 

 

 

Figure 100. CY8CKIT-059 Prototyping Kit Connected to a PC for firmware update 

 

4. Open the PSoC Programmer application on your computer. Once opened, verify that Powered and Connected status messages are 

displayed in the status bar – the bottom right side of the window (Figure 101). If not, please verify the CY8CKIT-059 Prototyping Kit is 

properly plugged into the USB port. 

 

Figure 101. PSoC Programmer GUI 
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If you received the Warning message “This Programmer is currently out of date”, or “The communication firmware on the kit does not 

match what is installed with the release of the PSoC Programmer”, click the OK button to navigate to the Utilities tab in the PSoC 

Programmer, and click the Upgrade Firmware button (Figure 102). When the firmware upgrade is completed, go back to the 

Programmer tab, and proceed to the next step. 

 

 

Figure 102. Programmer Firmware Update 

 

5. Next, select the firmware hex file mentioned in the step 2 by either pressing the Open Folder button (Figure 101, number 1) or through 

the menu (File>File Load) or by pressing the F4 key (Figure 101). 

6. Next, flash the firmware on the CY8CKIT-059 Prototyping Kit by pressing the Down Arrow button (Figure 101, number 2) or through the 

menu (File>Program) or by pressing the F5 key (Figure 101). 

 

• If the programming was successful, the Programming Succeeded message will appear in the Results window (Figure 103).  

 

 

Figure 103. Firmware Upgrade Success Message 
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7. You are now ready to use CY8CKIT-059 Prototyping Kit with the ROHM EVK GUI SW ! 

 

6.2 Firmware Update for Arduino UNO R3 

 

Updating firmware for Arduino UNO R3 contains the following phases: 

 

1. Download the avrdude zip package (Windows) from the avrdude official website. 

http//download.savannah.gnu.org/releases/avrdude/avrdude-6.4-mingw32.zip 

 

2. Following the installation of the ROHM EVK software, locate the Arduino folder from the computer in the following location:  

..\Documents\ROHM_EVK_v3\ROHM-EVK-Firmware\Arduino 

and verify the presence of a ROHM EVK Firmware file with the extension ”.hex” and the arduino_flash.bat file. 

 

3. Extract the downloaded avrdude-6.4-mingw32.zip package into “..\Documents\ROHM_EVK_v3\ROHM-EVK-Firmware\Arduino” – 

directory.  

 

4. Connect the Arduino UNO R3 into the USB port of the PC. 

1.  

5. Open a command prompt to the “..\Documents\ROHM_EVK_v3\ROHM-EVK-Firmware\Arduino” – directory and run arduino_flash.bat. 

COM port number of the connected Arduino UNO R3 is automatically detected. 

 

 

Figure 104, Firmware update for Arduino UNO R3 

 

  

http://download.savannah.gnu.org/releases/avrdude/avrdude-6.4-mingw32.zip
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7 Troubleshooting and known issues 

 

In case of connection problems or an application crash, please check the error log file of the ROHM EVK GUI SW. The default path of this file 

is: ..\Documents\ROHM_EVK_v3\ROHM-EVK-GUI\errorlog.txt 

 

7.1 Communication Troubleshooting 

 

7.1.1 RKX-EVK-001 Communication Issues 

 

The communication between the ROHM EVK GUI SW and RXK-EVK-001 may not work for several reasons. The issue can be related to 

hardware, software, or both. The following steps can be used as a guidance to troubleshoot such issues. 

 

7.1.1.1 “Status: EVK Disconnected” in ROHM EVK GUI SW Status Bar  

 

Figure 105. Status Bar, Disconnected 

 

This status means that the ROHM EVK GUI is not connected to the host adapter board. 

NOTE: This error example is limited for RKX-EVK-001 connections. 

 

If the text “Status: EVK Disconnected” appears in the Status bar, please check the following: 

 

Figure 106. ROHM-EVK-001 status: LED1, SW4, LED2, LED1 (CY8CKIT-059) must be ON 
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1. The blue LED1 (CY8CKIT-059) should be constantly ON and not blinking (Figure 106). 

 

• If the blue LED1 (CY8CKIT-059) is blinking, the CY8CKIT-059 is not programmed with the ROHM EVK FW. Please program 

the latest ROHM EVK FW. See (6.1 Firmware Update ) for details. 

• If the blue LED1 (CY8CKIT-059) is turned OFF, please try the following: 

 

• Check that the micro-USB cable is securely connected to the CY8CKIT-059 Prototyping Kit and to the USB port on the 

PC (Figure 87) 

• Connect to a different USB port on the PC. 

• Replace the micro-USB cable with a new, high quality, USB certified cable. 

 

2. The green LED1 (Figure 106).  

 

• If the green LED1 is OFF but the blue LED1 (CY8CKIT-059) is ON: 

• Ensure the CY8CKIT-059 Prototyping Kit is securely connected to the RKX-A3-EVK-001. 

 

7.1.1.2 “Status: No data in stream” in ROHM EVK GUI SW Status Bar 

 

This status means that the ROHM EVK GUI is not receiving any data from the device stream. 

 

 

Figure 107. Status Bar, No data 

NOTE: This error example is limited for RKX-EVK-001 connections. 

 

If the connection status as indicated in the status bar says “No data in stream”, the ROHM EVK GUI SW is not receiving any device data. To 

troubleshoot the issue, please check the following: 

 

This example case is valid for RKX-EVK-001 with an EVB. 

1. The orange LED2 should be ON (Figure 106). If the orange LED2 is OFF, check the following: 

Check if the SW4 is in the ON position (i.e., moved up as seen from above) (Figure 106).  

• If the SW4 is ON, check that the 7-position rotary switch SW2 (Figure 108 and Table 2) is not stuck in the intermediate position. 

The switch can be turned with a small flat screwdriver (Table 2). 

 

NOTE: When using the ROHM EVK GUI SW and the SW4 in the incorrect position, the Help menu item (4.1.9.4 About Host 

Adapter Board) would still work properly because the information about the host adapter firmware is read out from the CY8CKIT-

059 Prototyping Kit, not the sensor. 
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2. The orange LED2 is ON: 

• Check if the Stream selected corresponds to the sensor being tested (4.1.6 Stream - Menu). 

 

NOTE: The ROHM EVK GUI SW does not check the value of the WHO-AM-I register. Thus, while the stream for KX132-1211 

would work for KX134-1211 and vice versa (although SI values in Raw Data setting will be incorrect), neither of those streams 

would work if KXTJ3 sensor is connected and vice-versa. 

 

• Evaluation sensor board is securely connected to the ROHM EVK EVB either directly or with the ribbon cable (Figure 109). 

 

• Press the CY8CKIT-059 Reset Button (Figure 106). Wait a few seconds. If the status changes to “Connected”, press the 

“Streaming” button. 

 

• Unplug the CY8CKIT-059 Prototyping Kit from the PC and plug it back in. Wait a few seconds. If the status changes to “Connected”, 

press the “Streaming” button. 

 

• Close the ROHM EVK GUI SW. Unplug the CY8CKIT-059 Prototyping Kit from the PC. Plug in the CY8CKIT-059 Prototyping Kit 

and restart the GUI. 

 

7.1.1.3 USB performance issues 

 

• USB communication may miss device data samples – or the USB connection is lost randomly: Use good quality USB cables which are 

USB certified. 

• USB performance is not good on all Windows machines. The root cause is yet unknown. 

 

 

7.2 “EVK Mismatch” – state with the ROHM EVK GUI SW 

 

This error means that the firmware version is not compatible with the board configuration. Make sure that HW, board configuration and firmware 

versions are compatible. 

 

NOTE: This error example is limited for RKX-EVK-001 connections. 

For example, if the “EVK Mismatch” pop-up window appears you should check the “errorlog.txt”. 

 

If you can find following text in the errorlog.txt: 

####################### 

[ERROR] EVK Mismatch - state detected: 

“board_04ADC_10_RKX-EVK-001_spi_0” does not support the protocol version (2.0) of the firmware. 

Supported protocol versions in board config: [ 

  "2.4", 

  "3.1" 

] 

######################## 
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7.3 ODR accuracy and Timestamping 

 

• ROHM EVK GUI SW timestamping is done on a PC, and it is not accurate with high ODRs. This influences the delta time statistics. 

• The real-time ODR shown in the GUI may show fluctuating and be off the nominal ODR value. If the value is within ~10% of the nominal 

value, the behavior is normal and can be due to a combination of factors such as fluctuation of the actual sensor ODR due to internal 

oscillator jitter, as well as the timestamping error mentioned above. For cases where the ODR value is either significantly lower or higher 

than the nominal value, and “ODR has not reached the target value” pop-up window appears, see section (4.4.3 ODR has not reached 

the target value pop-up window) for details. 
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8 Appendix 

 

8.1 RKX-A3-EVK-001 Detailed Diagram 

 

For detailed information of the hardware, please refer to the ROHM EVK HW User's Guide. 

 

Figure 108. RKX-A3-EVK-001 Main Features 

Table 2. RKX-A3-EVK-001 Main Features 

1  TP4 - Test Point 4 for VBUS (Host) input voltage measurement  12  TP1 - Test Point 1 for GND reference voltage measurements  

2  LED2 - Orange LED is ON when VDD_SENSOR voltage is ON  13  J9 - Raspberry Pi 6-pin debug header  

3  
SW4 - Switch that connects VDD_SENSOR to 
VBUS/VR1_OUT  

14  J8 - Raspberry Pi 40-pin dual-row header  

4  LED1 - Green LED is ON when VBUS (Host) Voltage is provided  15  J15 - Infineon CY8CKIT-059 compatible header  

5  SW1 - VDD_SENSOR select switch (VBUS or VR1_OUT)  16  J14 - Infineon CY8CKIT-059 compatible header  

6.  J7 / R64 - VDD_Sensor current measurement header/bypass.  17  J4 - Arduino UNO R3 Compatible Digital Header (bottom mount)  

7  SW3 - IO_VDD Select switch (VDD_SENSOR of VR2_OUT)  18  J6 - ROHM EVK EVB compatible header  

8  
SW2 - 7-position rotary switch to configure VR1_OUT voltage:  
1 = 3.3V, 2 = 3.0V, 3 = 2.8V, 4 = 2.5V, 5 = 1.8V, 6 = 1.7V, 7 = 3.6V  

19  J10 - ROHM Sensor Module 5-Pin Digital / 4-Pin Analog Header  

9  TP3 - Test Point 3 for VDD_SENSOR voltage measurement.  20  J3 – Arduino UNO R3 Compatible Digital Header (bottom mount)  

10  J1 - Arduino UNO R3 Compatible Power Header (bottom mount)  21  J11 - ROHM 7-Pin Digital Sensor (SPI) Header  

11  
J2 - Arduino UNO R3 Compatible Analog Header (bottom mount, 
even-numbered pins).  

22  J5 - ROHM EVK EVB ribbon cable compatible header  
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8.2 Interface with ROHM EVK EVB  

 

 

Figure 109. Interface with ROHM EVK EVB 
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The information contained in this document is intended to introduce ROHM Group (hereafter 
referred to asROHM) products. When using ROHM products, please verify the latest specifications 
or datasheets before use.

ROHM products are designed and manufactured for use in general electronic equipment and 
applications (such as Audio Visual equipment, Office Automation equipment, telecommunication 
equipment, home appliances, amusement devices, etc.) or specified in the datasheets. Therefore, 
please contact the ROHM sales representative before using ROHM products in equipment or 
devices requiring extremely high reliability and whose failure or malfunction may cause danger or 
injury to human life or body or other serious damage (such as medical equipment, transportation, 
traffic, aircraft, spacecraft, nuclear power controllers, fuel control, automotive equipment including 
car accessories, etc. hereafter referred to as Specific Applications). Unless otherwise agreed in 
writing by ROHM in advance, ROHM shall not be in any way responsible or liable for any damages, 
expenses, or losses incurred by you or third parties arising from the use of ROHM Products for 
Specific Applications. 

Electronic components, including semiconductors, can fail or malfunction at a certain rate. Please 
be sure to implement, at your own responsibilities, adequate safety measures including but not 
limited to fail-safe design against physical injury, and damage to any property, which a failure or 
malfunction of products may cause. 

The information contained in this document, including application circuit examples and their 
constants, is intended to explain the standard operation and usage of ROHM products, and is not 
intended to guarantee, either explicitly or implicitly, the operation of the product in the actual 
equipment it will be used. As a result, you are solely responsible for it, and you must exercise your 
own independent verification and judgment in the use of such information contained in this 
document. ROHM shall not be in any way responsible or liable for any damages, expenses, or 
losses incurred by you or third parties arising from the use of such information. 

When exporting ROHM products or technologies described in this document to other countries, you 
must abide by the procedures and provisions stipulated in all applicable export laws and regulations, 
such as the Foreign Exchange and Foreign Trade Act and the US Expor t Administration 
Regulations, and follow the necessary procedures in accordance with these provisions.

The technical information and data described in this document, including typical application circuits, 
are examples only and are not intended to guarantee to be free from infringement of third parties 
intellectual property or other rights. ROHM does not grant any license, express or implied, to 
implement, use, or exploit any intellectual property or other rights owned or controlled by ROHM or 
any third parties with respect to the information contained herein.

No part of this document may be reprinted or reproduced in any form by any means without the 
prior written consent of ROHM.

All information contained in this document is current as of the date of publication and subject to 
change without notice. Before purchasing or using ROHM products, please confirm the latest 
information with the ROHM sales representative. 

ROHM does not warrant that the information contained herein is error-free. ROHM shall not be in 
any way responsible or liable for any damages, expenses, or losses incurred by you or third parties 
resulting from errors contained in this document. 

Thank you for your accessing to ROHM product informations.
More detail product informations and catalogs are available, please contact us.
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